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Important Safety Instructions 

Read and Retain Instructions 

Carefully read all safety and operating instructions before operating this equipment, and 
retain them for future reference.  

Follow Instructions and Heed Warnings 

Follow all operating and use instructions. Pay attention to all warnings and cautions in the 
operating instructions, as well as those that are affixed to this equipment. 

Terminology 

The terms defined below are used in this document. The definitions given are based on those 
found in safety standards. 

Service Personnel - The term service personnel applies to trained and qualified individuals 
who are allowed to install, replace, or service electrical equipment. The service personnel are 
expected to use their experience and technical skills to avoid possible injury to themselves 
and others due to hazards that exist in service and restricted access areas. 

User and Operator - The terms user and operator apply to persons other than service 
personnel. 

Ground(ing) and Earth(ing) - The terms ground(ing) and earth(ing) are synonymous. This 
document uses ground(ing) for clarity, but it can be interpreted as having the same meaning 
as earth(ing). 

Electric Shock Hazard 

This equipment meets applicable safety standards. 

WARNING! 

To reduce risk of electric shock, perform only the instructions that are included in the 
operating instructions. Refer all servicing to qualified service personnel only. 

Electric shock can cause personal injury or even death. Avoid direct contact with dangerous 
voltages at all times. The protective ground connection, where provided, is essential to safe 
operation and must be verified before connecting the power supply. 

Know the following safety warnings and guidelines: 

 Dangerous Voltages 

 Only qualified service personnel are allowed to perform equipment installation or 
replacement. 

 Only qualified service personnel are allowed to remove chassis covers and access any of 
the components inside the chassis. 

 Grounding 

 Do not violate the protective grounding by using an extension cable, power cable, or 
autotransformer without a protective ground conductor. 

 Take care to maintain the protective grounding of this equipment during service or 
repair and to re-establish the protective grounding before putting this equipment back 
into operation. 

 

Continued on next page 
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Important Safety Instructions, Continued 

Installation Site 

When selecting the installation site, comply with the following: 

 Protective Ground - The protective ground lead of the building’s electrical installation 
should comply with national and local requirements. 

 Environmental Condition – The installation site should be dry, clean, and ventilated. Do 
not use this equipment where it could be at risk of contact with water. Ensure that this 
equipment is operated in an environment that meets the requirements as stated in this 
equipment’s technical specifications, which may be found on this equipment’s data sheet. 

Installation Requirements 

  WARNING: 

Allow only qualified service personnel to install this equipment. The installation must 
conform to all local codes and regulations. 

 

Equipment Placement 

  WARNING: 

Avoid personal injury and damage to this equipment. An unstable mounting surface 
may cause this equipment to fall. 

To protect against equipment damage or injury to personnel, comply with the following: 

 Install this equipment in a restricted access location. 

 Do not install near any heat sources such as radiators, heat registers, stoves, or other 
equipment (including amplifiers) that produce heat. 

 Place this equipment close enough to a mains AC outlet to accommodate the length of this 
equipment’s power cord. 

 Route all power cords so that people cannot walk on, place objects on, or lean objects 
against them. This may pinch or damage the power cords. Pay particular attention to 
power cords at plugs, outlets, and the points where the power cords exit this equipment. 

 Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold 
with this equipment. 

 Make sure the mounting surface or rack is stable and can support the size and weight of 
this equipment. 

 The mounting surface or rack should be appropriately anchored according to 
manufacturer’s specifications. Ensure this equipment is securely fastened to the mounting 
surface or rack where necessary to protect against damage due to any disturbance and 
subsequent fall. 

Ventilation 

This equipment has openings for ventilation to protect it from overheating. To ensure 
equipment reliability and safe operation, do not block or cover any of the ventilation 
openings. Install the equipment in accordance with the manufacturer’s instructions. 

 

Continued on next page 
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Important Safety Instructions, Continued 

Rack Mounting Safety Precautions 

Mechanical Loading 

Make sure that the rack is placed on a stable surface. If the rack has stabilizing devices, install 
these stabilizing devices before mounting any equipment in the rack. 

  WARNING: 

Avoid personal injury and damage to this equipment. Mounting this equipment in the 
rack should be such that a hazardous condition is not caused due to uneven mechanical 
loading. 

Reduced Airflow 

When mounting this equipment in the rack, do not obstruct the cooling airflow through the 
rack. Be sure to mount the blanking plates to cover unused rack space. Additional 
components such as combiners and net strips should be mounted at the back of the rack, so 
that the free airflow is not restricted. 

  CAUTION: 

Installation of this equipment in a rack should be such that the amount of airflow 
required for safe operation of this equipment is not compromised. 

Elevated Operating Ambient Temperature 

Only install this equipment in a humidity- and temperature-controlled environment that 
meets the requirements given in this equipment’s technical specifications. 

  CAUTION: 

If installed in a closed or multi-unit rack assembly, the operating ambient temperature 
of the rack environment may be greater than room ambient temperature.  Therefore, 
install this equipment in an environment compatible with the manufacturer’s maximum 

rated ambient temperature. 

Handling Precautions 

When moving a cart that contains this equipment, check for any of the following possible 
hazards: 

 WARNING: 

 

Avoid personal injury and damage to this equipment! Move any 
equipment and cart combination with care. Quick stops, excessive 
force, and uneven surfaces may cause this equipment and cart to 
overturn. 

 Use caution when moving this equipment/cart combination to avoid injury from tip-over. 

 If the cart does not move easily, this condition may indicate obstructions or cables that may 
need to be disconnected before moving this equipment to another location. 

 Avoid quick stops and starts when moving the cart. 

 Check for uneven floor surfaces such as cracks or cables and cords. 

 

Continued on next page 
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Important Safety Instructions, Continued 

Grounding 

This section provides instructions for verifying that the equipment is properly grounded. 

Safety Plugs (USA Only) 

This equipment is equipped with a 3-terminal (grounding-type) safety plug. The wide blade 
or the third terminal is provided for safety. Do not defeat the safety purpose of the 
grounding-type or polarized safety plug. 

To properly ground this equipment, follow these safety guidelines: 

 Grounding-Type Plug - For a 3-terminal plug (one terminal on this plug is a protective 
grounding pin), insert the plug into a grounded mains, 3-terminal outlet. 

Note:  This plug fits only one way. If this plug cannot be fully inserted into the outlet, 
contact an electrician to replace the obsolete 3-terminal outlet. 

Grounding Terminal 

If this equipment is equipped with an external grounding terminal, attach one end of an 
18-gauge wire (or larger) to the grounding terminal; then, attach the other end of the wire to a 
ground, such as a grounded equipment rack. 

Safety Plugs (European Union) 

 Class I Mains Powered Equipment – Provided with a 3-terminal AC inlet and requires 
connection to a 3-terminal mains supply outlet via a 3-terminal power cord for proper 
connection to the protective ground. 

Note:  The equipotential bonding terminal provided on some equipment is not designed to 
function as a protective ground connection. 

Equipotential Bonding 

If this equipment is equipped with an external chassis terminal marked with the IEC 

60417-5020 chassis icon ( ), the installer should refer to CENELEC standard EN 50083-1 or 
IEC standard IEC 60728-11 for correct equipotential bonding connection instructions. 

AC Power 

Important:  If this equipment is a Class I equipment, it must be grounded. 

 If this equipment plugs into an outlet, the outlet must be near this equipment, and must be 
easily accessible. 

 Connect this equipment only to the power sources that are identified on the 
equipment-rating label normally located close to the power inlet connector(s). 

 This equipment may have two power sources. Be sure to disconnect all power sources 
before working on this equipment. 

 If this equipment does not have a main power switch, the power cord connector serves as 
the disconnect device. 

 Always pull on the plug or the connector to disconnect a cable. Never pull on the cable 
itself. 

 Unplug this equipment when unused for long periods of time. 
 

Continued on next page 
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Important Safety Instructions, Continued 

Circuit Overload 

Know the effects of circuit overloading before connecting this equipment to the power 
supply. 

  CAUTION: 

Consider the connection of this equipment to the supply circuit and the effect that 
overloading of circuits might have on overcurrent protection and supply wiring.  Refer 
to the information on the equipment-rating label when addressing this concern. 

General Servicing Precautions 

 WARNING: 

Avoid electric shock! Opening or removing this equipment’s cover may expose you to 
dangerous voltages. 

Be aware of the following general precautions and guidelines: 

 Servicing - Refer all servicing to qualified service personnel. Servicing is required when 
this equipment has been damaged in any way, such as power supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into this equipment, this equipment 
has been exposed to rain or moisture, does not operate normally, or has been dropped. 

 Wristwatch and Jewelry - For personal safety and to avoid damage of this equipment 
during service and repair, do not wear electrically conducting objects such as a wristwatch 
or jewelry. 

 Lightning - Do not work on this equipment, or connect or disconnect cables, during 
periods of lightning. 

 Labels - Do not remove any warning labels. Replace damaged or illegible warning labels 
with new ones. 

 Covers - Do not open the cover of this equipment and attempt service unless instructed to 
do so in the instructions. Refer all servicing to qualified service personnel only. 

 Moisture - Do not allow moisture to enter this equipment. 

 Cleaning - Use a damp cloth for cleaning.  

 Safety Checks - After service, assemble this equipment and perform safety checks to 
ensure it is safe to use before putting it back into operation. 

Electrostatic Discharge 

Electrostatic discharge (ESD) results from the static electricity buildup on the human body 
and other objects. This static discharge can degrade components and cause failures. 

Take the following precautions against electrostatic discharge: 

 Use an anti-static bench mat and a wrist strap or ankle strap designed to safely ground 
ESD potentials through a resistive element. 

 Keep components in their anti-static packaging until installed. 

 Avoid touching electronic components when installing a module. 

 

Continued on next page 
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Important Safety Instructions, Continued 

Electromagnetic Compatibility Regulatory Requirements 

This equipment meets applicable electromagnetic compatibility (EMC) regulatory 
requirements. EMC performance is dependent upon the use of correctly shielded cables of 
good quality for all external connections, except the power source, when installing this 
equipment. 

 Ensure compliance with cable/connector specifications and associated installation 
instructions where given elsewhere in this guide. 

Otherwise, comply with the following good practices: 

 Multi-conductor cables should be of single-braided, shielded type and have conductive 
connector bodies and backshells with cable clamps that are conductively bonded to the 
backshell and capable of making 360° connection to the cable shielding. Exceptions from 
this general rule will be clearly stated in the connector description for the excepted 
connector in question. 

 Ethernet cables should be of single-shielded or double-shielded type. 

 Coaxial cables should be of the double-braided shielded type. 

EMC 

Where this equipment is subject to USA FCC and/or Industry Canada rules, the following 
statements apply: 

FCC Statement for Class B Equipment 

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. 

This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver. 

 Connect the equipment into an outlet on a circuit different from that to which the receiver 
is connected. 

 Consult the dealer or an experienced radio/TV technician for help. 

Industry Canada – Industrie Canadienne Statement 

This apparatus complies with Canadian ICES-003. 
Cet appareil est confome à la norme NMB-003 du Canada. 

Fuse Replacement 

To replace a fuse, comply with the following: 

 Disconnect the power before changing fuses. 

 Identify and clear the condition that caused the original fuse failure. 

 Always use a fuse of the correct type and rating. The correct type and rating are indicated 
on this equipment. 

 

Continued on next page 
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Important Safety Instructions, Continued 

Modifications 

This equipment has been designed and tested to comply with applicable safety, laser safety, 
and EMC regulations, codes, and standards to ensure safe operation in its intended 
environment. 

Do not make modifications to this equipment. Any changes or modifications could void the 
user’s authority to operate this equipment. 

Modifications have the potential to degrade the level of protection built into this equipment, 
putting people and property at risk of injury or damage. Those persons making any 
modifications expose themselves to the penalties arising from proven non-compliance with 
regulatory requirements and to civil litigation for compensation in respect of consequential 
damages or injury. 

Accessories  

Use only attachments or accessories specified by the manufacturer. 
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Preface 

Overview 

About This Guide 

This guide provides the instructions for installing, setting up, and operating the Ethernet 
over COAX Element Management system (ECEM). This guide is subject to ECEM V 3.0.4. 

In This Guide 

This User Guide is divided into the following sections: 

Chapter 1: Introduction – This chapter provides a brief overview about ECEM. 

Chapter 2: Installing ECEM – This chapter describes how to install ECEM. 

Chapter 3: Setting up ECEM – This chapter describes how to initiate and set up ECEM, such 
as loading the license and user management. 

Chapter 4: Operating ECEM – This chapter provides information on device management, 
parameter configuration, and performance testing. 

Chapter 5: Customer Support Information – This chapter contains information on obtaining 
technical support. 

Additional Documentation 

Visit our website (http://www.scientificatlanta.com/TNS/index.htm to view additional 
publications about our products. 

You need a user name and password to access this website. If you do not have a user name 
and password, contact your customer service representative. 

Note: You may need to install a PDF reader, such as Adobe Acrobat Reader, on your system 
to view these publications. 

Note: You can download these guides separately, or find them on the CD that comes 
packaged with the master and end-point devices.  

Important Notice 

Please read the following notice before performing instructions in this guide.  

 NOTICE: 

Although DigiStar EoC Aggregation Point (AP) and End Point (EP) contain various 
types of offerings, the DigiStar EoC E220 IP54 and E320 can be considered as a typical 
DigiStar EoC AP and EP. All instructions in this guide are based on the DigiStar EoC 
E220 IP54 and E320. All instructions are applicable to all types of DigiStar EoC 
offerings.  

 

 

 

http://www.scientificatlanta.com/TNS/index.htm
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Chapter 1  
Introduction 

Overview 

Introduction 

This chapter provides a brief overview of the ECEM system.   

In This Chapter 

This chapter contains the following topics.  

Topic Page 

About ECEM 1-2 

Remote Management Application 1-4 
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About ECEM 

Introduction 

The DigiStar Ethernet over COAX (EoC) system is designed to combine CATV signals with 
Ethernet signals for transmission to the subscriber’s home through the existing coax access 
network.  

The Ethernet over COAX Element Management (ECEM) System is a uniform management 
platform that can remotely manage and monitor all master and end-point devices in the EoC 
network system. With remote accessing of master devices based on SNMP standard protocols, 
the ECEM System can monitor device status and report alarms in real time, configure key 
device parameters, upgrade device firmware, and test and analyze device performance, 
thereby reducing maintenance cost and improving management efficiency of a complex EoC 
network system.  

 

ECEM Features 

 Supports remote management based on SNMP protocol 

 User management: Add and Delete User  

 Device configuration including VLAN and Rate Limitation 

 Supports adding and deleting devices 

 Supports remote checking of status and firmware version of master and end-point devices 

 Real-time and fixed-time performance test for forward and reverse link 

 Real-time and fixed-time monitoring of end-point device data flow 

 Supports report and chart analysis for performance testing and data flow monitoring 

 Supports fault management from multiple E220s. 

 Firmware remote batch upgrade for master and end-point devices 

 Database support for user and device information reservation 

 Supports EP offline configuration 

 Automatic EP Join/Leave updates 

Continued on next page 
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About ECEM, Continued 

ECEM System 

The ECEM System offers comprehensive management for all master and end-point devices in 
a complex EoC network system. With remote access to master devices based on SNMP 
standard protocols, ECEM can monitor device status and report alarms in real time, configure 
key parameters, upgrade firmware, and test and analyze the device’s performance, thereby 
reducing maintenance cost and improving management efficiency. 

ECEM provides operators with following major benefits: 

1. General Management Platform – There are many devices (master and end-point) in an 
EoC network system, and these devices may be deployed in different MDUs, or areas. 
ECEM is designed as a platform to manage all master and end-point devices in a complex 
EoC network system through a user-friendly graphical interface. The number of managed 
devices and function modules can be defined by license. ECEM can reduce the cost of 
system maintenance with improved management efficiency. 

2. Comprehensive Device Management – Each AP device can be regarded as one device 
node in the Device Tree, and all end-point devices of this AP device will be loaded by 
double-clicking the node. The status of connection and access control configuration of the 
end-point device can be marked with color, helping the user to recognize the device’s 
working status and monitor the whole complex network. 

3. Online Monitoring and Testing – The device status of failed connection, new identified, 
and disabled access can be recognized by color. This helps the user identify failed devices, 
quickly locate the failure, and identify degradation in the EoC network. ECEM can create 
a task to test online device’s performance, and monitor the data flow.  

4. Online Configuration and Upgrade – ECEM can remotely configure the key parameters 
of the end-point devices (enable or disable the access control, VLAN ID, rate limit), and 
check and upgrade the online device’s firmware. You can also save, import, or export the 
device’s settings. This can reduce the difficulty of maintaining devices in the field, and 
allows for upgrading the whole network both quickly and on a large scale. You can access 
the online AP device’s internal management system via the embedded web browser in 
ECEM to implement the comprehensive management and status monitor. 

5. Performance Evaluation – With the optional SQL Server database support, ECEM can 
save the records of performance testing and dataflow monitoring tasks. By following the 
report wizard, you can generate several types of reports or charts to analyze the 
performance and communication activities of the devices.   

6. Open Standards – ECEM is a management system based on industry open standards such 
as SNMP and HTTP. 

Important Concepts 

The following items have been defined in ECEM.  

 Node: A node is defined as the virtual IP address of the root AP device. The host can 
remotely access this AP device via Ethernet network. The node is helpful in managing a 
large number of devices in an EoC system, even though these devices are not directly 
connected to the host. 
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About ECEM, Continued 

Names and Descriptions  

The following table shows the names and the descriptions of terms used in the ECEM system.  

 

Names Description 

AP (Aggregation Point)  E220 

EP (End Point)  E320 

Module  E220 Plug-in Module 

Device  AP (Aggregation Point), EP (End Point) 

Admin  The account that has full control of the ECEM system. 

User 
The account used to view the ECEM system 

configurations. Under the user account, no changes to 
the system configuration are allowed.  
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Remote Management Application 

Remote Management Architecture 

ECEM can remotely manage all online master and end-point devices in an EoC network 
system via Ethernet network. 

The following illustration shows the typical remote management architecture. 

E220 with ONU module inside:  

 

E220 with ONU outside: 

 

Note: 

1. In the above application, the master devices are connected via LAN interface, and are 
responsible for providing Ethernet and video signals to one MDU. The end-point 
devices should be deployed in each subscriber’s apartment in the unit.  

2. The end-point device can provide both Ethernet and CATV services to subscribers.  

3. Be sure that network resources are sufficient to provide the required number of master 
and end-point devices in each MDU, and to ensure adequate bandwidth for each 
subscriber.  

4. ECEM enables remote access to each online AP device’s internal management system via 
the Ethernet network. 
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Chapter 2  
Installation 

Overview 

Introduction 

This chapter contains the information on how to install ECEM.   

In This Chapter 

This chapter contains the following topics.  

Topic Page 

System Requirements 2-2 

Installing ECEM 2-3 

Connection 2-5 
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System Requirements 

System Requirements 

Make sure your computer meets the following requirements to install ECEM V2.9.2. 

Item Requirements 

Operating System 

Windows Server 2003/ 

Windows XP Service Pack 2/ 

Windows 2000/ 

Windows 7 

Disk Space At least 310 MB 

Display Minimal: 1024 x 768，16-bit high color  

Supporting Software 

ECEM may need the following software support according to your requirements.  

Software Items Descriptions 

Microsoft SQL Server 
(Optional) 

The ECEM software package does not include the Microsoft 
SQL server application. The SQL Server is used to store 
performance test results. ECEM provides a wizard to instruct 
EoC network administrators how to configure, test, and 
maintain the SQL Server.  
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Installing ECEM 

Installation Steps 

To install ECEM on the host, follow the instructions below. 

1. Run Setup.exe. The InstallAware Wizard starts. The installation program will collect the 
necessary information for installing ECEM on your computer.  

2. The .Net Framework 2.0 and Crystal Reports are required for running the ECEM. If 
the .Net Framework 2.0 and Crystal Reports have been installed, the installation wizard 
will start to install ECEM directly, go to step 4. 

 

3. If necessary, the wizard then installs the .Net Framework 2.0 and Crystal Reports.  

 
Continued on next page 
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Installing ECEM, Continued 

4. After completing the above steps as needed, the wizard proceeds to install ECEM.  

 

5. Accept the License Agreement by ticking the box before “I agree with the license 
agreements” and click Next. Type your user name and company information, and then 
select the installation path, and so on. 

6. ECEM is now installed.  

7. Click Finish to finish the installation.  

 

8. When uninstalling ECEM, the wizard only removes the ECEM program. We do not 
recommend that you uninstall the .NET Framework and Crystal Reports applications. 

 

Continued on next page 
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Connection 

Connection of Remote Management 

The following illustrations show a typical example for directly connecting to an Ethernet 
network. 

 

Note: 

1. The configuration of the network determines the number of master devices supported. 
Please refer to Remote Management Application for more information.  

 

Continued on next page 
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Connection, Continued 

Connection at Subscriber Home 

The end-point device should be deployed at the subscriber’s home. The following diagrams 
illustrate examples of a coax network connection, and user device connection. 

Coax Network Connection 

 

User Device Connection 
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Chapter 3  
Setting up ECEM 

Overview 

Introduction 

This chapter mainly introduces the layout and menus of ECEM, and provides a simple 
instruction about user management, and how to activate the license.  

In This Chapter 

This chapter contains the following topics.  

Topic Page 

License Management 3-2 

ECEM Overview 3-5 

User Management 3-12 

Alarm Management 3-14 
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License Management 

Introduction 

ECEM needs a license to activate the function modules. After installation, ECEM has no 
license installed, and therefore, no function modules are activated.  

The license is bonded to the host’s network adapter MAC address. To purchase a license, you 
should provide the host’s MAC address to the sale representative. Cisco Systems will then 
provide the correct license file in accordance with your actual requirements.  

To Launch ECEM 

Follow these steps to launch ECEM.  

1. Click Start menu, and then point to Programs. 

2. Point to ECEM, and then click ECEM to start up this program. 

3. When you launch ECEM for the first time, it notifies you that no valid license file is 
found.   

 

To Purchase a License 

1. To apply for a license, click License Status option from the Help menu.  

 

 

Continued on next page 
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License Management, Continued 

1. Click License Status. The license status dialog box appears. 

 

2. In the module list, all modules are invalid. Click Purchase Guide to get the host’s MAC 
address.  

 

Provide all contents in the text box to the sales representative. The representative needs 
this information to apply for a license from Cisco Systems. In the example shown above, 
the number “00166F3A3F17” is the host’s MAC address. 

 

Continued on next page 
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License Management, Continued 

To Load the License 

1. If you received the license file, click Upgrade to load the license.  

2. Click Browse, and then select the valid license file from your computer.  

 

3. Click Ok to load the license file. When the file loads successfully, the relevant function 
modules are activated.  

 

The license will show the maximum number of managed master and end-point devices. 
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ECEM Overview 

To log in to ECEM 

After loading the license, you can log in to ECEM using the default user name and password. 

Follow these steps to log in to ECEM.  

1. Choose Operators menu, and then click Log In.  

 

Note: You can also click  on the toolbar to quickly open the Log In dialog box. 

2. The Log In dialog box appears. 

 

For the first login, there is only one user “admin” in the Operator Name drop box. 

3. The default password of “admin” is 123456. In the Password text box, type the initial 
password, and then click OK. 

4. If you are a registered operator, select your ID from the Operator Name drop box, and 
then type your password to log in. 

5. After login, select the language (Simplified Chinese or English) for ECEM in the View 
menu.  

 
 

Continued on next page 
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ECEM Overview, Continued 

Layout 

The following screen shows the default layout after you log in to ECEM. 

 

You can use the View menu to adjust the layout and set various preferences for ECEM.  

 
Continued on next page 
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ECEM Overview, Continued 

 

Options Description 

Toolbar To show or close the shortcut icons on the toolbar. 

Statusbar To show or close the status bar. 

Device Tree To show the device tree diagram. 

Zone Tree To manage AP and discover AP feature in context menu. 

Device List To show the Devices table. 

Log To show the operation log event table. 

Web Browser To show the embedded web browser. 

Preference To set the Main Window theme, SNMP, FTP, Polling parameters, 
Data Field Selection and Renaming.  

 

Menu Items 

1. Operators menu 

 

 Log In – To log in to ECEM.  

 Log Out – To exit ECEM.  

 Change Password – To change the password of a registered operator.  

 Manage Operators – To add a new operator or delete a registered operator. 

Continued on next page 
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ECEM Overview, Continued 

2. View menu 

 

 View Device List – To view the device list which the operator saved. 

 View Test Result – To view the test results which the operator saved. 

 View Version – To view the version of selected device’s firmware. 

 Toolbar – To turn on or off the relevant tool shortcut icons. 

 Statusbar – To turn on or off the status bar. 

 Device Tree – To activate the Device Tree view. 

 Zone Tree – To activate the Zone Tree view. 

 Device List – To activate the Device List view. 

 Log – To show the system logging information list. 

 Web Browser – To activate the Web Browser window. 

 Language – To select the language (Simplified Chinese or English) for ECEM.  

 Preferences – To allow the user to set the Main Window theme, SNMP, FTP, Polling 
parameters, Data Field Selection and Renaming.  

 Note: Polling will check AP online status periodically. Set polling to 0 min to disable 
polling. 

 

Continued on next page 
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ECEM Overview, Continued 

3. Edit menu 

 

 Refresh Devices – Refresh the device list and their status. All new connected devices 
can be loaded under the Device Tree marked with light blue color. 

 Delete Device – Delete devices or nodes. If you delete a node, all devices of this 
node will be deleted.  

 Register Device – Register new devices into the database, or edit the device’s basic 
information.  

4. Configure menu 

 

 Check Version – Check the online device’s firmware version. 

 Configure Device – Configure the device’s key parameters.  

 Download Firmware – Upgrade the firmware for online devices. 

 Batch Upgrade – Upgrade a group of devices of firmware. There are three options: 

 Batch Master Firmware Upgrade 

 Batch Gateway Firmware Upgrade 

 Batch Endpoint Firmware Upgrade 

For details, please refer to Section B 
Configuration of Chapter 4 Operating ECEM. 

 

 

Continued on next page 
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ECEM Overview, Continued 

5. Performance menu 

The Performance menu is used to test the device’s performance.  

 

 Monitor Data flow – Create a task to monitor the device’s data flow.  

 Test Performance – Create a task to test the device’s performance.  

 Report Wizard – Instruct the user to generate reports and charts to analyze the 
device’s data flow and performance. 

6. Database menu 

The Database menu is used to configure, test, and maintain the SQL Server database.  

 

 Configure Database – Configure the Database to save the records of data flow 
monitoring and performance test.  

 Maintain Database – Maintain the records of the database.   

7. Help menu 

 

 License Status – To allow the user to purchase and load the license and to view the 
license’s status. 

 User Guide – To open the ECEM User Guide. 

 Report Issue – To report an issue to the contact person. 

 About ECEM – To view ECEM system information. 

 

Continued on next page 
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ECEM Overview, Continued 

Toolbar 

The following dialog box shows the Toolbar. The toolbar enables a quick launch of special 
function modules. If one function module is invalid, the related icon on the toolbar is also 
invalid.  

 

The following table gives the basic description of toolbar. 

Icons Hints Description 

 
Log In Log in to ECEM. 

 
Manage Operators Add a new user, or delete a registered user. 

 
Change Password Change the password of one registered operator. 

 
Refresh EP Device Refresh the device’s status, and find out new devices of 

one node. 

 
Register Device Register new devices into the database, or edit the 

device’s basic information. 

 View Device List View the device list. 

 View Test Result View the test results. 

 
View Version View the device firmware version. 

 
Check Version Check an online device’s firmware version. 

 
Configure Device Configure the device functionality. 

 
Download Firmware Upgrade an online device’s firmware. 

 
Monitor Data Flow  Create a task to monitor a device’s data flow. 

 Test Performance Test an online device’s performance. 

 
Alarm Management Manage the alarm thresholds. 

 

 



4025954 Rev E                                                                                       3-12 

User Management 

Introduction 

This section provides instructions for adding a new user, deleting a registered user, and 
changing the password.  

Note: The user account is enabled to view all the system configurations while any change to 
the system configurations is allowed. Please switch to admin account if you are expecting to 
make changes to the system configurations.  

To Add or Delete a User 

Note: Only the admin account has the privilege to delete users. The admin account is also 
enabled to add more Admin accounts. 

1. Click  on the toolbar, or choose Operators menu, and then click Manage 

Operators.  

The Manage Operators dialog box appears. 

 

2. To add a new user, click Add and then type the new user name and password into the 
appropriate text boxes. ECEM will not distinguish between uppercase and lowercase 
letters.  

3. Click Add again. A new operator has been added successfully.  

4. To delete a user, click Delete, and then select the targeted registered user from the 
Operator name drop box.  

 

5. Click Delete again to delete the selected operator. The operator “admin” cannot be 
deleted. 

Continued on next page 
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User Management, Continued 

Changing a Password 

The default administrator of ECEM can change the password for all registered users without 
knowing their current passwords. Registered users can only change their own passwords.  

Follow these steps to change the password. 

1. Click  on the toolbar, or choose Operators menu, and then click Change Password.  

The Change Password dialog box appears. 

 

2. Choose your user name from the drop-down box, and then type your current password 
and new password separately into the appropriate text boxes.  

Note:  

 For a registered user, only your own password can be changed. The administrator 
can change all registered users’ passwords, and does not need to type the current 
passwords of the selected registered users.  

 ECEM will not inform the registered user automatically after the administrator 
changes his or her password, so the registered user needs to get help from the 
administrator if he or she finds that the password was changed.   

3. Click OK. The password has been changed.  
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Alarm Management 

Introduction 

This section provides instructions on how to manage alarms by changing the threshold.  

To View Alarms 

Click  on the toolbar, or choose View menu, and then click Fault Management. The 
following screen shows an example of the alarms ranked chronologically. 

 

Note: Once the alarm thresholds are exceeded, the alarms are activated. The severity of 
alarms are distinguished and highlighted by colors. The sustained user data traffic which 
lasts for more than 10 minutes is necessary to activate the SNR alarm function. 

To Change Thresholds 

1. Click the  button. The following screen is displayed.  

 

2. Change the number in High Temperature tab from “60.0” to the expected number 
(“20.0” in this case), and check the boxes in line with the corresponding APs to be 
changed. Or check the box before the Select All tab if you want to change Alarm 
Thresholds for all APs in the network. 

 

3. Click the Apply button. 

4. After viewing the following status reminder, the configuration is successful. Click the 
Quit button. 
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Chapter 4  
Operating ECEM 

Overview 

Introduction 

This chapter contains necessary information for EoC network administrators regarding 
ECEM, including device management, performance testing, and parameter configuration. 

In This Chapter 

This chapter contains the following sections.  

Topic Page 

Section A Device Management 4-2 

Section B Device Configuration 4-15 

Section C Performance Test 4-27 
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Section A 
Device Management 

Overview 

Introduction 

There are many devices (master and end-point) in a typical EoC network system, and these 
devices may be deployed in different MDUs, or areas. ECEM is designed as a platform to 
manage all master and end-point devices in a complex EoC network system through a 
user-friendly graphical interface. The number of managed devices and function modules are 
defined by the license.  

There are two tabs for viewing and managing the devices: Zone Tree and Device Tree. Zone 
Tree displays AP and its affiliations in geographical locations. The Device Tree shows the 
relationship between both AP and EP in a hierarchical way.  

Note: You can find shortcut menus for some device management functions by right-clicking 
in the Devices table, as shown below. 

 

 

In This Section 

This section contains the following topics.  

Topic Page 

Adding a Node 4-3 

Discovering AP 4-6 

AP Polling 4-8 

Registering a Device 4-9 

Deleting Devices 4-11 

Loading and Refreshing Devices 4-12 

Viewing Device List 4-14 
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Adding a Node 

Introduction 

The remote master devices should be defined as a node in Zone Tree. The end-point devices 
can be loaded by double-clicking the online master device in the Device Tree. If the master 
device is offline, the end-point device cannot be loaded into the Device Tree.  

To Add a Node 

Follow these steps to add a new node. 

1. Right-click on the Zone Tree diagram. 

 
Continued on next page 
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Adding a Node, Continued 

1. Click Add. The Add dialog box appears. Before adding the new node, fill in the City, 
District, Street, and Building information by selecting Add from the pop-up menu, 
which is activated by right-clicking the established geographical location. 

 

After Building has been filled out, right-click it and select Add to access Add New Node 
dialog box. 

 

2. Type the IP address of the remote master device. The IP address you add should be the 
IP address of the master device’s LAN interface. You can also use this IP address to 
access this master device via an embedded browser.  

Note: The default IP address of the remote master device’s LAN interface is 
192.168.1.254. You should use a public IP address (which you can get from your ISP 
service provider) for each master device to replace the default IP address of the LAN 
interface. For details on changing the default IP address of the master device’s LAN 
interface, refer to the DigiStar EoC Master E220 Installation and Operation Guide (part 
number 4034992).  

  

Continued on next page 
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Adding a Node, Continued 

3. Click Add. The new node is added to the Zone Tree. 

 

4. After adding a node, right-click the node to open its context menu, and then click 
Manage AP from the menu to begin loading the end-point devices.  

 

5. Click Yes at the prompt window shown below to add the new EP. 

 

Result: The master device and its end-point devices will be regarded as new devices 
(marked with light blue color). The new devices should be registered to the database. 
Refer to the section Registering Nodes for more information.  

 
Continued on next page 



4025954 Rev E                                                                                       4-6 

Discovering AP 

Introduction 

Discovering AP allows you to look through APs that are available for adding to the network.  

To Discover AP 

1. Select the entry at the Building level from the four levels of City, District, Street, and 
Building. Right-click the Building entry, and then select Discover AP. 

 

2. Click Scan to start scanning for available APs. 

 

3. If a new AP is found, the following window appears. 

 

Continued on next page 
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Discovering AP, Continued 

 

1. Click Yes. The new AP will be displayed in the Zone Tree tab, as shown below. 

 

2. Click Yes to add the unregistered AP. For details on registering the AP, refer to 
Registering a Device for more information.  
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AP Polling 

Introduction 

The Polling feature, if turned on, can periodically check AP online status. 

To Turn on / Turn off AP Polling 

1. Select Preferences from the View menu.  

2. Select Polling from the Preferences menu. 

 

3. Set Polling to 0 to turn off the Polling. The default time interval for an AP online status 
check is every 5 minutes. 
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Registering a Device 

Introduction 

This feature allows registering all new devices in the database, including both AP and EP. 
You can edit each device’s basic information at the time you register it. 

To Register a Device 

1. Select a device from the Device Tree, and then click the Register Device option from the 
Edit menu.  

 

Note: You can also right-click a device in the Devices list, and then click the Register 

Device option. Or, you can click the  button on the toolbar to open the Register 

Device dialog box. 

 

2. Enter the basic information of the selected device in the appropriate text boxes.  

 
Continued on next page 
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Registering a Device, Continued 

 

3. After typing the user name, address, telephone number, and email address, click Save to 
save the basic information for this device to the database. 

Result: The configuration of the device is shown in the device list. See the screen below: 

 

To View Device Configuration 

Click the Synchronize button.  

Result: The configuration of the EP will be displayed. See the screen below:  
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Deleting Devices 

To Delete Devices 

Follow these steps to delete devices.  

1. Select the device which you want to delete, and then click the Delete Device option in 
the Edit menu.  

 

Or, right-click the device, and then click the Delete Device option.  

 

Or, to delete an AP device, right-click a device in the Zone Tree, and then select Delete 
from the pop-up menu.  

 

Note: If you delete one master device, all end-point devices below this master device will 
also be deleted.  
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Loading and Refreshing Devices 

To Load and Refresh Devices 

Use the refresh device operation to load and refresh the device’s status and to find new 
devices. 

1. Click the Refresh Devices option from the Edit menu. 

 

Or, right-click any place in the Device Tree diagram, and then choose the Refresh 

Devices option from the menu. 

2. An offline end-point device is marked with red color. If a new device is found, it will be 
added under the device marked with light blue color.  

 

3. You can view the details in the Devices List table. 

 

4. Click Register All. All devices are registered to the database without basic information. 
You can edit their configurations separately.  

5. Click Export. The registered device list is saved to a file (the default save location is the 
folder …\ECEM\files\DeviceUser). 

6. Right-click anywhere in the Device Tree diagram, and then Click Search AP. Type the 
condition of an AP in the text box in the Search Devices menu, and then click Find to 
find detailed information about an AP.  
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Loading and Refreshing Devices, Continued 

 

 

 

7. Or click Search EP, type the MAC address of an EP in the text box in the Search Devices 
menu, and then click Search to find detailed information about an EP.  
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Viewing the Device List 

Introduction 

You can view the device list, if you have saved one. The device list is different from the 
records in the database.  

To View the Device List 

Follow these steps to view the device list.   

1. Click the View Device List option from View menu, or click  on the toolbar.  

2. Choose the device list from the specified folder (…/Files/DeviceUser/). 

 

3. Choose the History Device List table to view details.  
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Section B 
Configuration 

Overview 

Introduction 

This section provides EoC network administrators with information on how to configure the 
device’s parameters, upgrade device firmware, and access the remote master device’s 
internal management system for monitoring and configuration via an embedded browser. 

In This Section 

This section contains the following topics.  

Topic Page 

Configuring Devices 4-16 

Firmware Management 4-18 

Accessing the Online Master Device 4-25 
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Configuring Devices 

Introduction 

This section describes how to configure the end-point devices. 

To Configure the Devices 

Follow these steps to configure the end-point device.   

1. Choose the target end-point devices (one or more devices) from the Device Tree or the 
Devices table.  

2. Click the Configure Device option from the Configuration menu, or click  on the 
toolbar. 

 

Note: A short-cut for configuring device parameters is also accessible by right-clicking 
the Devices table.  

Result: The Configure EP dialog box appears.  

 

 

Continued on next page 
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Configuring Devices, Continued 

The following list provides a detailed description of the configuration options. 

 Upstream Rate Control:  

1. Includes the option to set the upstream data rate of Data Link Layer from the 
Upstream drop-down box.  

2. Includes the option to set the limit for host from the HostLimit drop-down box.   

 Port Configuration: includes the option to choose configure LAN 1 and LAN 2. 

1. Enable Port 1/2: includes the option to enable or disable the port access. 

2. VLAN Enable: includes the option to enable or disable the VLAN 

3. VLAN ID: includes the text box to input the VLAN ID.  

Note: VLAN ID should not be identical for different ports in real operations. 
Otherwise, if both ports have the same VLAN ID, the uni-cast traffic will only come 
from Port 1 of the EP.  

4. Downstream Rate: includes the option to set the upstream data rate of Data Link 
Layer from the drop-down box. 

5. Priority: includes the text box to input the priority of the VLAN from 0 to 7.  

 Details: This area summarizes the configuration results.  

Click Apply Setting to apply the new settings.  
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Firmware Management 

Introduction 

ECEM supports remote downloading and upgrading of online device firmware. It also 
allows the user to view and check the firmware version. 

To Set the FTP 

1. Set the local IP address. 

  

2. Open the preferences dialog box. 

3. Click on the FTP tab, and check the IP address under FTP Server Options. If the text box 

turns red with the inappropriate setup, click  and choose the right address in the 
popup box.  

 

4. Click the Test button to test the FTP server settings. Proceed to the next step only if the 
FTP server settings are OK. 

 

Continued on next page 
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Firmware Management, Continued 

To Download Online Device Firmware 

Use this procedure when upgrading one AP master firmware, or when upgrading firmware 
for multiple endpoints attached to the same AP. 

1. Select one or more target devices from the Device Tree or the Devices table.  

2. Click Download Firmware in the Configuration menu, or click  on the toolbar.  

 

3. Click Browse to select the firmware image file (the filename must match the EoC model 
number).    

 

4. For the E220 master, select the AP image file with the band configurations for your 
network.  

File Name Downstream Upstream Unit 

E220_DS12-28_US12-28.bin 12-28 12-28 MHz 

E220_DS12-44_US12-44.bin 12-44 12-44 MHz 

E220_DS12-44_US28-44.bin 12-44 28-44 MHz 

E220_DS28-44_US28-44.bin 28-44 28-44 MHz 

 

Continued on next page 
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Firmware Management, Continued 

5. Click Download to start upgrading the selected device’s firmware image.  

 

6. The Details box includes the log details. 

7. ECEM allows you to remotely upgrade the device’s firmware image in the internal 
management system. Refer to Accessing the Web UI, on page 4-25 for more 
information.   

To Upgrade Online Master Device Firmware 

Depending on the device to be upgraded, there are three categories of devices: master, 
gateway, and endpoint. Use this procedure when upgrading multiple AP masters’ firmware.  

1. Select Batch Upgrade from the Configuration menu.  

 

2. Select Batch Master Firmware Upgrade to upgrade master firmware. 

 

3. Click Firmware to select the firmware image file to be upgraded (the master or endpoint 
firmware image file is located in the folder ...\ECEM\files\Firmware). 

 

Continued on next page 
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Firmware Management, Continued 

 

4. Select the AP image file with the band configurations for your network.  

File Name Downstream Upstream Unit 

E220_DS12-28_US12-28.bin 12-28 12-28 MHz 

E220_DS12-44_US12-44.bin 12-44 12-44 MHz 

E220_DS12-44_US28-44.bin 12-44 28-44 MHz 

E220_DS28-44_US28-44.bin 28-44 28-44 MHz 

5. Click the checkbox to tick it and to select the master device you want to upgrade. 

6. Click Start to start upgrading. You can click Current Status for details during 
upgrading. 

To Upgrade Gateway Firmware  

Use this procedure when upgrading multiple AP gateways’ firmware. 

1. Select Batch Upgrade from the Configuration menu, and then select Batch Gateway 

Firmware Upgrade. 

2. Click Open to select the gateway firmware image file to be upgraded (the gateway 
firmware image file is located in the folder ...\ECEM\files\WebFirmware). 

 

Continued on next page 
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Firmware Management, Continued 

3. Click the checkbox to tick it and to select the gateway device you want to upgrade.  

 

4. Enter your AP username and password. 

5. Click Update to start upgrading. 

To Upgrade Online Endpoint Device Firmware 

Use this procedure when upgrading multiple endpoints’ firmware for different APs.  

1. Select Batch Upgrade from the Configuration menu, and then select Batch EP Firmware 

Upgrade. 

2. Click Firmware to select the firmware image file to be upgraded (the master or endpoint 
firmware image file is located in the folder ...\ECEM\files\Firmware). 

 

3. Click the checkbox to tick it and to select the endpoint device you want to upgrade. 

4. Click Update to start upgrading. You can click Current Status for details during 
upgrading. 

To View the Firmware Version 

You can view the device’s firmware information, which is saved as a file when you check the 
device’s firmware.   

1. Click View Version in the View menu, or click  on the toolbar.  

2. Choose the version file from the specified folder (…/Files/Version). 

 

Continued on next page 
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Firmware Management, Continued 

 

3. The firmware information of all devices is listed in View Firmware Version table. 

 

To Check Device Firmware 

You can check the online device’s current firmware version. This procedure is important 
when you want to upgrade or update the device’s firmware.  

1. Select the target devices from the Devices table. 

2. Click Check Version in the Configuration menu, or click  on the toolbar.  

3. The Check Version dialog box appears. 

 

Continued on next page 
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Firmware Management, Continued 

 

4. Click View to view its current firmware information.  

 

5. Click Save. The current firmware version is saved to the database.  

6. Click Export to save the current firmware version to a file.  
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Accessing the Web UI 

Introduction 

ECEM allows accessing the Web User Interface (UI) via the embedded web browser. If you 
have its user name and password, you can login to the Web UI system to remotely manage 
and monitor the online master device.  

To Remotely Access the Web UI 

Follow these steps to remotely access the online master devices via Ethernet network. 

1. Open the embedded web browser by clicking Web browser in the View menu. 

2. Type the URL address in the embedded browser.  

 

Note: You should type the IP address of this master device’s LAN interface, such as 
http://192.168.1.254. 

3. Click Enter or  to open the Log In dialog box.  

 

To Configure the AP with Web UI 

Refer to the DigiStar Ethernet over COAX (EoC) Aggregation Point (AP) Web User Interface 
(UI) User Guide for the configuration of the AP, part number 4040429, after you have 
finished the mounting of the AP. This document provides information on how to configure 
the E220 via its internal management system by using a laptop or PC.  

Visit our website (http://www.scientificatlanta.com/TNS/index.htm to view additional 
publications about our products. 

You need a user name and password to access this website. If you do not have a user name 
and password, contact your customer service representative. 

Note: You may need to install a PDF reader, such as Adobe Acrobat Reader, on your system 
to view these publications. 

Note: You can download these guides separately, or find them on the CD that comes 
packaged with the master and end-point devices. 

 

 

http://www.scientificatlanta.com/TNS/index.htm
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Section C 
Performance Testing 

Overview 

Introduction 

In addition to analyzing the device’s performance, ECEM can also collect performance data. 
ECEM supports testing device performance and monitoring device data flow.  

This section contains information for EoC network administrators about how to test device 
performance, perform remote testing, and monitor data flow.  

In This Section 

This section contains the following topics.  

Topic Page 

Configuring the Database 4-28 

Testing Performance 4-31 

Monitoring Data Flow 4-33 

Report Analysis 4-34 
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Configuring the Database 

Introduction 

The Microsoft SQL server can be used to save all test and monitor records from monitoring 
data flow and testing remote devices. If you have installed the Microsoft SQL server, follow 
the steps in this section to configure and maintain the SQL server database. 

Note: Be sure to install the SQL server on the same host where ECEM is installed. 

 

To Configure the Database 

1. Click the Configure Database option in the Database menu. 

 

2. ECEM automatically finds the SQL server you installed on the host. 

Note: If ECEM does not find the server, it displays the following warning. 

 

Continued on next page 
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Configuring the Database, Continued 

 

3. If you have already prepared the SQL server to save the test and monitor records, you 
can specify the name of the SQL server.   

 

4. The wizard creates a new database on the SQL server for saving ECEM records.  

5. If you specify an account on the SQL server for safety use, you can cancel the option of 
Integrated Safety, and then type the user name and password.  

6. Click Ok. The wizard reminds you that all existing data will be lost after configuration. 

7. Click Yes to configure the SQL Server. After successful completion, the wizard displays 
a confirmation notice.  

 

8. To clear old records from the database, choose the Maintain Data option from the SQL 

Server menu. 

 

Continued on next page 
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Configuring the Database, Continued 

 

In the Maintain Data dialog box, choose the type of records, specify the date, and then 
click Clear to delete the corresponding records from the database.  
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Testing Performance 

Introduction 

ECEM can set a task to automatically test device performance within a specified time 
window. If you have SQL Server database support, you can save the test results to the 
database.1  

Note: Data flow to the endpoint is required for performance testing statistics to be valid. 

To Set a Task to Test Device Performance 

1. Select the target devices from the Devices table.  

Important: Remote testing requires establishing a data link between one master device 
and one end-point device of this master. To do this, you must select one master device 
and one end-point device of this master (at least) for testing. However, the master device 
cannot establish a data link to one end-point device of another master device. So, when 
selecting devices for this test, be sure to note the relation of master and end-point 
devices.  

2. Click the Test Performance option in the Performance menu. 

 

Note:  

 You can also click  on the toolbar to open the Test Remote Devices dialog box. 

 A short-cut for remote testing is accessible by right-clicking the Check Device List 

table.  

 If you have SQL Server support, the results can be saved to the database.  

 

Continued on next page 

                                                           
1
 Link Loss is only available for AP and EP Tx directions. 
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Testing Performance, Continued 

3. Set the time range and the save mode.  

For auto save mode: 

 This mode sets the intervals for the next task. If the connection to the SQL server is 
established, all test results will be saved to the database.  

 The time interval counts from the end of the last task.    

For guide save mode: 

 If the connection to the SQL server is established, click Save to save the test results 
to the database.    

4. Click Start to start monitoring the remote device’s performance. Click Stop to end this 
task.  

5. The results are displayed in the Records table. 

Note: The results of one task in the Record table will be replaced by the results of the 
next task. For guide mode, you need to click Save to save them to the database.  

6. Click Export. The results are saved as a file. 
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Monitoring Data Flow 

Introduction 

ECEM can set a task to monitor online device data flow. If you have SQL Server database 
support, you can save the results to the database.  

Monitoring Online Device Dataflow 

1. Select the target devices from the Devices table.  

2. Click the Monitor Data Flow option in the Performance menu. The monitor data flow 
dialog box appears.  

 
Note:  

 You can also click  on the toolbar to open the Monitor Data Flow dialog box. 

 A short-cut for monitoring data flow is accessible upon right-clicking the Devices 

table.  

 If you have SQL Server support, the results can be saved to the database.  

3. Set the time range. In the Data Flow Configuration dialog box, the time and date 
synchronize with the host’s current date and time.  

4. Select the save mode.  

 Auto save mode sets the intervals for next task. If the connection to the SQL server 
is established, all test results will be saved to the database.  

 The time interval counts from the end of the last task.   

 For guide save mode, click Save to save the results to the database.   

5. Click Start to start monitoring the local device’s data flow. Click Stop to end this task.  

6. The results are displayed in the Results table.  

Note: The results of one task in the Results table will be replaced by the results of the 
next task. For guide mode, you must click Save to save them to the database.  

4. Click Clear to empty the Results table. This does not clear the records in the database. 
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Report Analysis 

Introduction 

This section explains how to generate different charts and reports for analyzing device data 
flow. Follow the report wizard to make report settings and generate the corresponding report 
or chart. 

Note: Be sure that there are saved records in the database of the target devices and that the 
SQL server is running normally.    

Report Wizard 

1. Click the Report Wizard option in the Performance menu. 

 

 

Continued on next page 
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Report Analysis, Continued 

2. Choose the report type. There are two report types to analyze device data flow.  

 

 Text – To produce a text report that analyzes the performance or data flow. 

 Chart – To produce a chart that analyzes the performance or data flow. 

 

Continued on next page 
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Report Analysis, Continued 

1. Set up the time range. 

 

You can also select a time range for analysis. 

 

 

Continued on next page 
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Report Analysis, Continued 

3. Choose the data category and content type.  

 

 Data category – You can choose to analyze the device’s performance or a device’s 
monitored data flow.  

 Content type – ECEM gives you two choices for displaying the analysis results as an 
illustration. The evolution report illustrates changes in device performance or data 
flow over the specified time period. The comparison report illustrates differences in 
performance or data flow between two end-point devices. 

 The evolution report is useful for analyzing a single device, while the comparison 
report is provided for comparing two device’s performance or data flow.  

 For the data flow analysis, you must select one master device and one end-point 
device to establish a communication link between these two devices. The comparison 
report is not available for data flow analysis.  

 When using the comparison report, you can select only one parameter for analysis per 
report. 

 

Continued on next page 
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Report Analysis, Continued 

1. Select the target device for analysis.  

 

You can select the device from a specified device list, or just select from the default list.  

 

 

Continued on next page 
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Report Analysis, Continued 

1. Select the parameters for analysis. You can load the default parameter list by clicking 
Load Parameters. 

 

You can also configure the parameter options by clicking Configure Parameter Set. 

 

This parameter set is available for performance analysis. 

 

Continued on next page 
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Report Analysis, Continued 

 

This parameter set is available for data flow analysis. 

4. Review your settings in the report summary (see example below), and then click Finish 
to start generating the report.  

 

 

Continued on next page 
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Report Analysis, Continued 

The following are two report samples.  
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Chapter 5  
Customer Support Information 

Overview 

Introduction 

This chapter contains information on obtaining technical support.  

Obtaining Product Support 
 

IF… THEN… 

you have general questions about this 
product 

contact your distributor or sales agent for 
product information or refer to product 
data sheets on www.cisco.com. 

you have technical questions about this 
product 

call the nearest Technical Service center. 

you have customer service questions about 
this product 

call the nearest Customer Service Center. 

In This Chapter 

This chapter contains the following topics 

Topic See Page 

Support Telephone Numbers 5-2 
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Support Telephone Numbers 

This table lists the Technical Support and Customer Service numbers for your area. 

Region Centers Telephone and Fax Numbers 

North America Cisco Services 

Atlanta, Georgia  
United States 

For Technical Support, call: 

 Toll-free: 1-800-722-2009 

 Local: 678-277-1120  (Press 2 at the prompt) 

For Customer Service, call: 

 Toll-free: 1-800-722-2009 

 Local: 678-277-1120  (Press 3 at the prompt) 

 Fax: 770-236-5477 

 E-mail: customer-service@cisco.com 

Europe,  
Middle East,  
Africa 

Belgium For Technical Support, call: 

 Telephone: 32-56-445-197 or 32-56-445-155 

 Fax: 32-56-445-061 

For Customer Service, call: 

 Telephone: 32-56-445-444 

 Fax: 32-56-445-051 

 E-mail: service-elc@cisco.com 

Japan Japan  Telephone: 81-3-5908-2153 or +81-3-5908-2154 

 Fax: 81-3-5908-2155 

Korea Korea  Telephone: 82-2-3429-8800 

 Fax: 82-2-3452-9748 

 E-mail: songk@cisco.com 

China (mainland) China  Telephone: 86-21-2401-4433 

 Fax: 86-21-2401-4455 

 E-mail: eoc-support@cisco.com 

All other  
Asia-Pacific 
countries & 
Australia 

Hong Kong  Telephone: 852-2588-4746 

 Fax: 852-2588-3139 

 E-mail: support.apr@sciatl.com 

Brazil Brazil  Telephone: 11-55-08-9999 

 Fax: 11-55-08-9998 

 E-mail: fattinl@cisco.com or 
ecavalhe@cisco.com 

 

Continued on next page 
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Support Telephone Numbers, Continued 

 

Mexico,  
Central America, 
Caribbean 

Mexico For Technical Support, call: 

 Telephone: 52-3515152599 

 Fax: 52-3515152599 

For Customer Service, call: 

 Telephone: 52-55-50-81-8425 

 Fax: 52-55-52-61-0893 

All other  
Latin America 
countries 

Argentina For Technical Support, call: 

 Telephone: 54-23-20-403340 ext 109 

 Fax: 54-23-20-403340 ext 103 

For Customer Service, call: 

 Telephone: 770-236-5662 

 Fax: 770-236-5888 

 E-mail: keillov@cisco.com 
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